Visualizing individual microtubules by bright field microscopy

Braulio Gutiérrez-Medina a)
Department of Biology, Stanford University, Stanford, California 94305

Steven M. Block b)
Department of Biology and Department of Applied Physics, Stanford University, Stanford, California 94305

(Received 11 February 2010; accepted 21 May 2010)

Microtubules are slender (~25 nm diameter), filamentous polymers involved in cellular structure and organization. Individual microtubules have been visualized via fluorescence imaging of dye-labeled tubulin subunits and by video-enhanced, differential interference-contrast microscopy of unlabeled polymers using sensitive CCD cameras. We demonstrate the imaging of unstained microtubules using a microscope with conventional bright field optics in conjunction with a webcam-type camera and a light-emitting diode illuminator. The light scattered by microtubules is image-processed to remove the background, reduce noise, and enhance contrast. The setup is based on a commercial microscope with a minimal set of inexpensive components, suitable for implementation in a student laboratory. We show how this approach can be used in a demonstration motility assay, tracking the gliding motions of microtubules driven by the motor protein kinesin.

I. INTRODUCTION

Since its introduction over 400 years ago, the optical microscope has proven to be an indispensable tool in biological research, providing the means to study a multitude of processes within living cells. The spatial resolution of light microscopy is traditionally limited by diffraction considerations to approximately \( \lambda / 2 \) or larger, where \( \lambda \) is the wavelength of the illumination light. Despite this intrinsic limitation, submicroscopic macromolecules (with dimensions of ~20–200 nm) or assemblies of macromolecules that scatter light weakly can be visualized in isolation (that is, when separated by distances larger than the resolution limit) by a variety of imaging techniques that rely on fluorescence or polarization effects to enhance the limited contrast.

One cellular component whose study has greatly benefited from advances in microscopy is the microtubule. Microtubules are polymerized from the protein tubulin and are long, hollow filaments involved in cellular structure, organization, and division. The lengths of microtubules typically range from several hundreds of nanometers to several micrometers, but they are all just ~25 nm in diameter, corresponding to ~\( \lambda / 20 \). Specialized imaging techniques that have been used to visualize isolated microtubules, with varying degrees of success, include fluorescence, dark field, phase contrast, and Nomarski differential interference-contrast microscopy. All of these approaches require exceptionally bright and uniform sample illumination, typically necessitating the use of an arc lamp, laser, or fiber-optic scrambler illuminator. The images obtained are generally enhanced by computer-based video processing to subtract the background, reduce the noise, and increase the useful contrast range. By using video-enhanced Nomarski differential interference-contrast imaging, it is even possible to visualize unstained bacterial flagella (~15 nm diameter). Advanced imaging methods are widely used throughout biophysical research but can be prohibitively expensive for implementation in the student laboratory.

In this paper we show that the light distribution produced using conventional bright field optics in a microscope is sufficient, with appropriate illumination and image processing, to visualize submicroscopic filamentous structures, and therefore affords a low-cost alternative for microtubule localization. We take advantage of the fact that the intensity of the light scattered from an elongated cylinder scales as \( (r / \lambda)^4 \), where \( r \) is the radius of the cylinder. This dependence contrasts with the steeper \( (r^2 / \lambda^2) \) dependence for scattering from a sphere of radius \( r \), making filaments more accessible to bright field imaging than spherical nanoparticles such as quantum dots.

Our setup is based on a commercial microscope with simple and inexpensive modifications that contribute to robust imaging. An inexpensive, super-bright light-emitting diode (LED) was used for illumination, together with a budget microscope objective, and a board-level black-and-white video camera. Open source software was used to perform subsequent image manipulations. The demonstrations described in the following are intended to acquaint students with the key concepts of light scattering, the importance of proper alignment of microscope optics, and the advantages of image processing to visualize weakly scattering objects. We provide detailed instructions on how to prepare biological samples to perform an in vitro demonstration experiment using the bright field microscope to measure microtubule displacements driven by the molecular motor kinesin.

II. EXPERIMENTAL SETUP

Bright field illumination is the simplest configuration for the light microscope and is available on almost all student microscopes. In the bright field configuration, the illuminating light travels from the source directly through the condenser to the sample, and both the scattered and unscattered light are collected by the objective and subsequently imaged via an eyepiece or a projection lens into the eye or a camera, as shown in Fig. 1(a). We use this basic configuration without introducing additional optical components such as filters, polarizers, or prisms.
these requirements, we used an inverted microscope condenser iris opening.

scopes fulfill these criteria. Figure 1

emerged as a cost-effective, high-quality alternative to arc lamps for light microscopy illumination. LEDs have recently been used to visualize microtubules using Nomarski differential interference-contrast optics. Shorter wavelength

Fig. 1. Schematic of the basic optical pathway and microscope apparatus used for microtubule visualization. (a) The arrangement of various microscope lenses (vertical lines with arrowheads) and apertures (vertical segmented lines) used for Köhler illumination. The illumination (gray lines) and imaging (black dotted lines) pathways are indicated. Short vertical lines (gray or black) below the optical pathway show the two sets of (reciprocal) conjugate planes. CL: Collector lens; FD: Field diaphragm; CD: Condenser diaphragm; C: Condenser; and O: Objective. (b) The microscope and components of the video-computer interface. The LED illuminator and the collector lens are mounted on a lens tube housing that is bolted to a heat sink. The camera tube and its projection lens are positioned to obtain the desired magnification. A baffle covers the path between the end of the camera lens tube and the CCD camera to block room light.

A. Microscope

To optimize image quality and contrast, the microscope must allow for the independent adjustment of various elements, particularly the components of the illumination system (the light source and collector lens position, and the field iris opening), the condenser (condenser lens position and condenser iris opening), and the objective focus. To satisfy these requirements, we used an inverted microscope (Zeiss, model Axiovert 100), but many other economical microscopes fulfill these criteria. Figure 1(b) shows a schematic of our microscope, which was equipped with a video camera port and a hand-built x-y translation stage (based on micrometers) to support the sample holder. We anticipate that students will have access to an equivalent instrument, or will build the necessary setup using separate optical and mechanical components. The inverted microscope configuration is not required, but it provides an excellent platform for optical elements to implement additional techniques such as laser-based optical trapping and fluorescence microscopy used in biophysical studies.

B. Illumination

During the past few years, super-bright LEDs have emerged as a cost-effective, high-quality alternative to arc lamps for light microscopy illumination. LEDs have recently been used to visualize microtubules using Nomarski differential interference-contrast optics. Shorter wavelength (blue) diodes give improved images, as anticipated from the wavelength-dependence of light scattered by submicroscopic filaments. We used a high-power blue LED array for illumination (up to 700 mW of emitted power and peak emission of 455 nm). This LED has a radiation profile proportional to the cosine of the forward angle, thereby making it possible to approximate the emitter as an optical point source. The simple hand-made servo circuit shown in Fig. 2 was used to drive the array at constant current (650 mA). Similar LED control circuits have been published. The LED was mounted on the cap of a 2 in. diameter lens tube (Thorlabs) and attached to a heat sink. Inside the tube, a 2 in. diameter collector lens (f=60 mm) collimated the emitted light. The tube ensured that the LED array was centered with respect to the collector lens, and internal threads allowed for adjustment of the focus depth.

C. Objective and condenser

Imaging techniques that rely on fluorescence, phase, or polarization to visualize submicroscopic objects often require the use of specialized microscope objectives with the highest possible numerical aperture (NA), minimal chromatic and spherical aberrations, and reduced stress to limit polarization distortions. The extraordinary care and materials required in the production of such objectives make them expensive (costing from thousands to tens of thousands of dollars). In contrast, it is possible to achieve the bright field technique using inexpensive “student-grade” objectives, provided that they have sufficiently high NA. We tested two different oil-immersion objectives from Edmund Optics: The 100X DIN Plan Commercial Grade (NA=1.25), and the 100X DIN Semi-Plan, Spring Loaded International Standard (NA=1.25). We found that the semi-plan lens produced images of somewhat better quality. The oil-immersion condenser used was part of the Zeiss system (NA=1.4), but the lens quality is not as critical on the condenser (illuminator) side.
D. Camera

We tested two inexpensive, black and white, board-level CCD cameras: The Videology model 20VC3617 and the Sentech model STC-130CS. Although it was possible to visualize single microtubules using the Videology camera, the best images were obtained using the Sentech camera. This device has a 1/3 in. CCD with 510 × 492 active pixels, measures 35 × 35 mm², and is easy to mount. The camera output was connected directly to a video frame grabber board (National Instruments, PCI-1405).

E. Image acquisition and processing

Video images were acquired for subsequent processing using custom software programmed in LABVIEW, version 7.1.1, equipped with the add-on package VISION (National Instruments). The flexibility of this software enabled us to implement two image processing methods in real time: Background subtraction and frame averaging (LABVIEW code available upon request). By using background-subtracted, averaged images, it was possible to adjust the microscope focus, sample, and illumination until the microtubules were clearly visualized, at which point further images were collected at a typical rate of ~1 frame per second (fps). Data were stored as avi files. To further enhance the contrast and visibility, subsequent video processing was performed using the freeware programs VIRTUALDUB 1.7.3 (Ref. 21) and IMAGEJ 1.42Q. VIRTUALDUB was mainly used to crop and resize large video files. IMAGEJ was used to implement image extraction operations that transformed the gray-scale images to binary masks, allowing the automated tracking of moving microtubules (see Secs. V and VI).

III. SAMPLE PREPARATION

All preparations and experiments are performed at room temperature, except when noted. Although microtubules are dynamic polymers in the cellular environment (undergoing periods of steady growth followed by rapid shrinking events), we work with stabilized microtubules produced by polymerization in the presence of the anticancer drug Taxol. In the Appendix, we provide a protocol to prepare reconstituted, stable microtubules using proteins and other reagents obtained from commercial sources. Students should be closely advised by instructors familiar with the requirements for safe handling of any reagents and biochemistry-associated equipment.

To prepare a sample of microtubules for observation, a simple microscope flow cell is constructed by placing two pieces of double-sticky tape on a 3 × 1 in.² glass microscope slide, creating a channel ~5 mm wide, and covering it with a #1.5 thickness coverslip (see Ref. 13, Fig. 2). If the coverslip is used directly from the box without further treatment, the attachment of microtubules to the surface tends to be minimal. Instead, we suggest chemically or mechanically cleaning the coverslip first by treating it for several minutes with ethanolic KOH (a solution of ethyl alcohol saturated with potassium hydroxide) followed by a thorough rinsing in purified water or by the use of a plasma cleaner (Harrick Plasma) for 5 min at ~1 Torr. Once the flow cell is made, about ~20 μl of microtubules in solution (see Appendix) is dispensed into one side of the flow channel using a micropipette, while filter paper (or a pipette tip connected to a vacuum line) is used to wick (or suction) away the excess liquid at the opposite side of the channel. We recommend adding a dilute sample of polystyrene beads (Spherotech, diameter of 300–800 nm) to the microtubule solution prior to flowing into the chamber (a final bead dilution of 1/10,000 is sufficient). Some of these beads will stick to the surface and coat it sparsely. These beads can aid significantly in locating the (nearly invisible) coverslip surface during alignment and focusing of the microscope. After the microtubule solution is introduced into the chamber, the sample is left for 5 min, allowing microtubules to adsorb to the glass nonspecifically.

The flow cell is then rinsed by injecting ~40 μl of PEMTAX buffer solution (see Appendix) through the channel to remove any unbound microtubules or beads. Finally, the channel openings of the flow cell are sealed using vacuum grease or nail polish to prevent evaporation or fluid movement.

IV. ALIGNMENT OF THE MICROSCOPE

Careful alignment of the microscope optimizes the capabilities of the instrument and is essential for the experiments described in this paper. In bright field microscopy, improved image resolution, contrast, and fidelity are achieved by means of Köhler illumination. An extended discussion of the principles of Köhler illumination, together with a detailed procedure for alignment, can be found in Ref. 9. In brief, the microscope lenses must be positioned, beginning with the light source, in such a way as to satisfy three optical conditions. First, the collector lens must image the light source into the rear focal plane (entrance pupil) of the condenser where the condenser diaphragm is located, creating a set of plane waves that illuminate the sample. Second, the condenser lens must image its field diaphragm (located next to the collector lens) in the sample plane, which has the effect of placing the light source in an optical plane that is reciprocal to the sample plane. This arrangement scrambles any nonuniformity associated with the extended light source because any given point in the light source is imaged into all points of the sample, leading to homogeneous, bright illumination. Finally, the objective lens and subsequent optics are adjusted to image the sample onto the camera, as shown in Fig. 1(a).

In Köhler illumination, two mutually reciprocal sets of conjugate planes are formed. The first set includes the condenser field diaphragm, the sample plane, and the camera sensor plane. The second set includes the light source and the rear focal plane (entrance pupil) of the condenser and the back focal plane (exit pupil) of the objective. Köhler illumination provides the additional advantage that the numerical aperture of the condenser (and therefore the illumination) can be adjusted independently using the condenser iris, enabling the use of the light source as either an extended or (nearly) point source. This feature allows for further adjustment of the contrast, which is necessary for imaging fine specimen features.

To align the microscope, we adopt an iterative procedure. We begin by adjusting the collector lens axially (using the threaded rings that secure it within the 2 in. lens tube) such that an image of the LED array is produced ~1–2 m away from the lens, nearly collimating the light source. This illuminator assembly is then mounted to the top of the microscope. An “alignment” flow cell is prepared by incubating for 5 min a ~1000-fold dilution of beads in PEM buffer (see the Appendix), washing and sealing the cell, and mounting it.
on the microscope using immersion oil. Next, the condenser iris diaphragm is opened fully, and the condenser position is dropped to provide enough illumination. The objective is then focused so that clear images of surface-bound beads are seen on the camera. We then close the field diaphragm almost entirely, and the condenser height is adjusted such that the diaphragm edges are clear and sharp in the field of view. At this stage, the distance between the collector lens and the condenser diaphragm \( d \) is measured (to within \( \approx 1 \) cm). In the next iteration, we demount the illumination assembly and now adjust the position of the collector lens (within the 2 in. lens tube) such that an image of the LED array is produced at the same measured distance from the collector lens. The illuminator assembly is then remounted, centered, and secured. We repeat adjustments of the objective (to image surface-bound beads) and the condenser (to image the edges of the nearly closed field diaphragm). At the last stage of alignment, the field iris is opened so that it just barely overfills the field of view. At this point, the microscope should be set up for full Köhler illumination. To visualize low-contrast microtubules, the condenser iris should be closed almost entirely (\( \approx 85\% \)), which further enhances contrast by producing an effectively point-like illumination source.

V. IMAGING INDIVIDUAL MICROTUBULES

A flow cell carrying microtubules plus a few beads bound to the coverslip is prepared (see Sec. III) and mounted on the microscope. While viewing with the camera (or through the eyepiece), the sample surface is located by focusing on the beads. It is also possible to use the double-stick tape at the perimeter of the flow cell channel as a guide to focusing or even small amounts of debris bound to the surface. No free beads should be diffusing within the field of view (any excess should have been removed by the rinse step during preparation of the flow cell) because these interfere with background subtraction. After focusing the objective on the bound beads, the condenser and the field diaphragm are re-adjusted for Köhler illumination.

Figure 3(a) shows that microtubules typically cannot be imaged without further video processing. Therefore, the sample chamber is moved using the \( x \)-\( y \) translation stage to a region where no beads are present, the objective is defocused by a small amount (typically a micrometer or so above the surface), and a number of background images (typically 200) are acquired and then averaged to provide a reference background image that is subsequently subtracted from all incoming frames. The second step for visualizing microtubules is to perform frame averaging. Microtubules can barely be made out in a single background-subtracted video frame but are readily seen in \( \sim 10 \) or more averaged frames. To complete the alignment, we slowly refocus the objective back toward the surface while looking carefully at the processed images. As illustrated in Figs. 3(b)–3(d), individual microtubules appear as elongated, slender objects, roughly aligned in the direction of flow in the sample chamber.

The procedures we have described can provide real-time videos of microtubule images. Subsequent offline image processing using IMAGEJ can make it possible to identify and outline microtubules with particular orientations automatically (see sequence shown in Figs. 4–9). Many useful image processing features are available using IMAGEJ, and students are encouraged to experiment with these. Here, we describe a few of the manipulations that significantly improved the quality of our video images. First, we started with a reference image based on an average of 30 frames (see Fig. 5) and implemented spatial filtering using the macro \( \text{Process } \rightarrow \text{FFT } \rightarrow \text{Band-pass filter} \). This procedure computes the fast Fourier transform of the image, removes components corresponding to specified spatial frequencies, and applies the inverse Fourier transform, returning a filtered image with reduced noise and background (as shown in Fig. 6). We typically suppress large structures down to 40 pixels and small structures up to 5 pixels. To enhance features in the vertical (horizontal) direction only, the option \( \text{Suppress stripes Horizontal (Vertical)} \) was used. Second, we made extensive use of smoothing and enhancement using spatial convolution routines. In one dimension, the convolution operation for two continuous functions \( f(x) \) and \( g(x) \) is defined as \( f \otimes g(x) = \int f(x) \cdot g(x-y) \, dy \). The discrete, two-dimensional version of this operation used for image processing is \( B_{i,j}=\sum_{m,n} I_{i-m,j-n} \cdot M_{m,n} \), where \( B_{m,n} \) is the processed image, \( I_{i,j} \) is the original image, and \( M_{m,n} \) is the convolution mask.
or kernel. This pixelwise convolution operation modifies a target pixel by adding weighted contributions from its neighbors, contributions that are specified in a kernel, a square matrix (typically, 3 × 3 or 5 × 5). Kernels that we found to be useful for enhancing our images acted preferentially along a particular direction, for example,

\[
\begin{pmatrix}
0 & 1 & 0 \\
0 & 1 & 0 \\
0 & 1 & 0
\end{pmatrix}
\quad \text{or} \quad
\begin{pmatrix}
1 & 0 & -1 \\
2 & 1 & -2 \\
1 & 0 & -1
\end{pmatrix}
\]  

(1)

The first kernel produces smoothing along the vertical direction and is implemented in IMAGEJ using Process → Filters → Convolve. The second kernel enhances vertical image features and boundaries, creating a shadow effect. The commands Process → Shadow implement this macro. Figure 7 shows that when used with bright field images, the combination of FFT-band-pass filter, Convolve, and Shadow macros can create impressive digital images of single microtubules whose quality is strikingly similar to those obtained by higher-end analog methods, such as Nomarski differential interference-contrast.

After image enhancement, the signal-to-noise ratio of microtubule images is large enough to apply a threshold (Image → Adjust → Threshold) to retain the most salient features, as shown in Fig. 8. Threshold-adjusted, gray-scale images are converted to binary images (Process → Binary → Make binary) and then directly into mask frames (Process → Binary → Convert to Mask) to allow automated feature extraction. This last operation can be performed with the macro Analyze → Analyze Particles, which scans for and retains features with a minimum size (specified in pixels²; we typically use ∼500 px²) and circularity (between 0 and 1). Enabling the option Show Mask displays the extracted features conveniently in a new window. Figure 9 shows an example of such a procedure.

VI. A KINESIN MOTILITY ASSAY

Kinesin is a motor protein that ferries cargo inside cells (typically vesicles) using the filamentous microtubules as

Fig. 5. A reference image used for sequential modifications based on an average of 30 frames as in Fig. 4. Individual microtubules are observed in various orientations. Field of view, 15 × 15 μm².

Fig. 6. The reference image from Fig. 5 after FFT band-pass filtering to remove large structures down to 40 pixels and small structures up to 5 pixels, along with suppression of horizontal features. Field of view, 15 × 15 μm².

Fig. 7. The reference image from Fig. 6 after the application of a convolution filter using a kernel that smooths and shadows in a diagonal direction. Note that horizontal structures are almost nonexistent. Field of view, 15 × 15 μm².

Fig. 8. The reference image from Fig. 7 after the application of a threshold operation to retain only the highest-intensity features, from which a binary mask is obtained. Field of view, 15 × 15 μm².
The flow channel and then incubated for the presence of ATP, as displayed in Fig. 10, which kinesin motors are fixed to the coverslip and thereafter instrument by implementing the "gliding-filament" assay in which kinesin motors are fixed to the coverslip and thereafter allowing the heads to bind and translocate microtubules in the presence of ATP, as displayed in Fig. 10(a).

A flow cell is prepared, and a sample of ≈20 μl reconstituted kinesin solution (see the Appendix) is introduced into the flow channel and then incubated for ≈10 min at room temperature. The flow cell is washed with ≈200 μl motility buffer (containing ATP) to remove any unbound motors, and a solution of microtubules diluted in motility buffer is introduced (see the Appendix). Finally, the flow chamber is sealed and mounted on the microscope, after which the imaging procedure is initiated. Once the microtubules are clearly visualized in background-subtracted, averaged images (averaging over ≈30 frames), their gliding motions should become noticeable within a few seconds. It is compelling to observe single microtubules move steadily across the microscope field of view (over distances of tens of microns), occasionally changing directions and even circling around sticky points. In this demonstration assay, we use kinesin at comparatively high concentration so that multiple motors are involved in displacing a single microtubule. It is also possible to conduct the same assay (but with greater difficulty) at low motor concentrations so that microtubules are driven by single motors.

We typically collect 50–150 successive images of moving microtubules (based on a 30 frame average per image). Using the off-line processing described in Sec. V, we extract the shapes of selected individual, kinesin-driven microtubules, a procedure illustrated in Figs. 10(b)–10(d). The centroid (optical center-of-mass) coordinates of the moving microtubules are obtained with ImageJ using the macro Analyze $\rightarrow$ Set Measurements $\rightarrow$ Center of Mass followed by Analyze $\rightarrow$ Analyze Particles macro, with the Display Re-

$sults$ option enabled. This automated procedure extracts a set of centroid coordinates (in pixels) that need to be converted into true distance units. Distance calibration is done separately by imaging a commercial, low-cost stage micrometer slide (Microscope World, model MA285-6), which carries a grating with rulings spaced at 10 μm intervals, and by counting the number of pixels contained between scale markers, from which the pixels-to-microns conversion factor is established.

A typical microtubule trajectory is shown in Fig. 10(d), where a single microtubule is outlined. The corresponding graph of distance versus time is displayed in Fig. 10(e) and...
shows the characteristic variation in the translocation speed. Typical microtubule velocities observed (≈200 nm/s) were ≈2-fold lower than the maximum reported for this particular kinesin protein,23 which we attribute to the nonspecific binding of kinesin molecules to the coverslip and to the presence of multiple motors in this assay (where a single nonfunctional head can interfere with its functional neighbors). In this assay, the tracking of microtubules could be extended to 3 min or more and is limited mainly by vertical drift that eventually defocused the image.

VII. CONCLUSIONS AND REMARKS

We have shown how individual microtubules can be visualized by computer-enhanced, bright field microscopy employing an array of economical lenses, cameras, illuminators, and other components. The apparatus and demonstration experiment we have described are appropriate for advanced undergraduate and graduate students in physics and biology programs. As an extension of the experiment, the kinesin motility assay can be done in the single-molecule regime, where the coverslip surface is so sparsely coated with motors that only single kinesin molecules move a microtubule. Doing so would allow students to measure the torsional flexibility of kinesin by scoring the angular motions of microtubules.26 The apparatus could also be combined with a simple optical trap (optical tweezers) and used with a bead-based assay for movement,13 making it possible to measure the force developed by single kinesin molecules as they walk along microtubules. Mechanical properties of microtubules, such as the flexural rigidity or the persistence length, can be estimated by tracking the thermal fluctuations in shape of filaments constrained to move in the two-dimensional space defined by placing the coverslip in close proximity to a coverslip.

ACKNOWLEDGMENTS

This work was supported by a grant from the National Institutes of Health to S.M.B. The authors thank the members of the Block Laboratory for helpful discussions.

APPENDIX: BUFFERS, MICROTUBULE, AND KINESIN PREPARATIONS

Tubulin (for polymerizing into microtubules) and kinesin proteins were purchased from Cytoskeleton and supplied in vials containing lyophilized samples.26 Although most of the necessary chemicals for the motility buffers used in these assays are available from Sigma, an alternative option would be to purchase pre-made buffers from Cytoskeleton. Cytoskeleton also offers preformed microtubules along with a complete kinesin motility kit suitable for use in the demonstration experiment.27 In the following, we give protocols showing how to resuspend lyophilized tubulin and kinesin and how to polymerize microtubules from tubulin and stabilize them and suggest dilutions for optimal viewing in the microscope. Where equivalent buffers or solutions are available from Cytoskeleton, we indicate the corresponding catalog number in square brackets.

1. Buffers and solutions used

PEM buffer [BST01]: 80 mM Pipes, pH 6.9, 1 mM EGTA, 4 mM MgCl₂; TAXOL (Paclitaxel) [TXD01]: 2 mM in DMSO; PEMTAX: dilute 5 µl TAXOL in 1 ml PEM; GTP [BST06-001]: 100 mM in PEM; PEMGTP: dilute 1 µl GTP in 99 µl PEM; storage buffer: 80 mM Pipes, pH 6.9, 50 mM, potassium acetate, 4 mM MgCl₂, 2 mM DTT, 1 mM EGTA, and 20 µM ATP; motility buffer: 80 mM Pipes, pH 6.9, 50 mM potassium acetate, 4 mM MgCl₂, 2 mM DTT, 1 mM EGTA, 10 µM taxol, 2 mg/ml BSA, and 2 mM ATP.

2. Microtubule polymerization

Resuspend lyophilized tubulin by adding 100 µl PEMGTP, yielding 10 mg/ml tubulin (TUB). Then, combine (60.8 µl PEMGTP+2.2 µl DMSO+4.8 µl TUB) and incubate the mixture at 37 °C for 30 min to grow microtubules. In the meantime, mix (83.6 µl PEM+1.0 µl GTP+9.4 µl 65 g/l NaNO₃+6.0 µl TAXOL; STAB). After incubation, stabilize microtubules by adding 8 µl STAB to the preparation. Microtubules stabilized in this manner can be stored at room temperature for several weeks. To view under the microscope, microtubules are diluted in PEMTAX buffer, typically 1:100.

3. Kinesin-microtubule assay

Resuspend lyophilized kinesin by adding 10 µl of storage buffer, yielding 2.5 mg/ml kinesin. For long-term storage (up to 6 months), we recommend adding 10 µl glycerol, mixing, and storing frozen at −20 °C. For use in the motility experiment, 1 µl of the resuspended kinesin solution is diluted into 99 µl motility buffer. Kinesin can only survive in functional form at room temperature for a few hours, and we therefore suggest keeping all kinesin samples on ice until use, and preparing fresh samples after ~1 h or so of observation. For the demonstration experiment, the microtubule stock solution is diluted in motility buffer, typically 1:200.

26 Present address: Instituto Potosino de Investigación Científica y Tecnológica, Camino a la Presa San José 2055, CP 78216, San Luis Potosí, S.L.P., México. Electronic mail: bgutierrez@ipicyt.edu.mx
27 Electronic mail: sblock@stanford.edu
1 R. Hooke, Micrographia, or Some Physiological Descriptions of Minute Bodies Made by Magnifying Glasses (J. Martyn and J. Allestray, London, 1665).
2 E. Hecht, Optics, 4th ed. (Addison-Wesley, Reading, MA, 2002).
11 H. C. Van de Hulst, Light Scattering by Small Particles (Dover, New York, 1957).
12 S. P. Smith, S. R. Bhalotra, A. L. Brody, B. L. Brown, E. K. Boyd, and...


17 Luxeon, V Star, Royal Blue Lambertian, Cat. No. LXHL-LR5C.

Synchronous Spark Timer. This high voltage source was designed to give high voltage sparks at a rate of 120 per second. In years past it was used with the Behr Free Fall apparatus to record the position of a falling plummet. The Behr apparatus had a length of red wax-coated paper running from top to bottom. The temporally well-defined spark jumped from the plummet to a wire behind the paper, locally melting the wax as it passed through and leaving a series of red dots behind. I have used it to trace out the orbit of a Foucault pendulum swinging in an elliptical orbit on a large sheet of spark paper placed between a sharp point on the pendulum bob and a flat piece of sheet metal under it. Many a lab instructor has done a high-voltage dance when using this device. It is in the Greenslade Collection. (Photograph and Notes by Thomas B. Greenslade, Jr., Kenyon College)